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READ ME FIRST

Welcome to Take Control of Font Problems in Mac OS X: Tiger
Edition, version 1.0, the companion volume to Take Control of Fonts
in Mac OS X: Tiger Edition.

This ebook is all about Mac OS X font problems: what they are, what
causes them and, of course, how to fix them. It covers both general
and very specific problems that you might encounter in using your
Mac, its font-related utilities, and the most popular applications—
like Microsoft Office and Adobe’s Creative Suite.

This ebook was written by Sharon Zardetto Aker, edited by Tonya
Engst, and published by TidBITS Electronic Publishing.

To get in touch or learn more about the Take Control ebooks, you can:
« Contact us by sending email to tc-comments@tidbits.com.

« See About This Ebook to learn about the author and publisher.

« Read the fine print on the copyright page.

- Find answers to general questions by reading the FAQ at
http://www.takecontrolbooks.com/faq.html.

« Buy another ebook by checking out our Featured Titles or by
visiting http://www.takecontrolbooks.com/catalog.html.

The price of this ebook is $10. If you want to share it with a friend,
please do so as you would with a physical book, meaning that if your
friend uses it regularly, your friend should buy a copy. The Help a
Friend button on the cover makes it easy for you to give your friend
a discount coupon.

We may offer free minor updates to this ebook. Click the Check for
Updates button on the cover to access a Web page that informs you
of any available or upcoming updates. On that page, you can also
sign up to be notified about updates via email.
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Onscreen Reading Tips

We carefully designed the Take Control ebooks to be read onscreen,
and although most of what you need to know is obvious, note the
following for the best possible onscreen reading experience:

« Work with the Bookmarks tab or drawer showing so that you can
always jump to any main topic by clicking its bookmark.

 Blue text indicates links. You can click any item in the Table of
Contents to jump to that section. Cross-references are also links,
as are URLs and email addresses.

 After following a link, you can easily return to the previous
location in your document. This table summarizes the necessary
menu commands and keyboard shortcuts:

How to Quickly Navigate to a Previous Point in This Ebook

Software

Menu Command Keyboard Shortcut

Adobe Acrobat 6 | View > Go To > Previous View | Command-Left arrow

Adobe Acrobat 5 | Document > Go To > Previous | Command-Left arrow

View

Preview

Go > Back Command-[

« In Adobe Acrobat Pro version 6 or 7, set your preferences to view
Web URLSs in a Web browser: choose Acrobat > Preferences, switch
to the Web Capture pane, and choose In Web Browser from the
Open Web Links pop-up menu.

« Find more tips in the Take Control FAQ on the Web.

Printing Tips

Although our layout is aimed at making online reading an enjoyable
experience, we’ve made sure that printing remains a reasonable
option. Please review these tips before you print:

« Use the Check for Updates button on the cover to make sure you
have the latest version of the ebook and to verify that we don’t plan
to release a new version shortly. If you want to commit this ebook
to paper, it makes sense to print the latest possible version.
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« Don’t throw out your PDF after you print! You must click the
Check for Updates button on the cover to get future updates. The
link must be accessed from the cover of your PDF.

« For a tighter layout that uses fewer pages, check your printer
options for a 2-up feature that prints two pages on one piece of
paper. For instance, your Print dialog may have an unlabeled pop-
up menu that offers a Layout option; choose Layout, and then
choose 2 from the Pages per Sheet pop-up menu. You may also
wish to choose Single Hairline from the Border menu.

« When printing on a color inkjet printer, to avoid using a lot
of color ink (primarily on the yellow boxes we use for tips and
figures), look for an option to print entirely in black-and-white.

+ In the unlikely event that Adobe Acrobat or Adobe Reader cannot
successfully print this PDF, try Preview; several readers have
solved printing problems by using Preview.

Basics

When reading this ebook, you may get stuck if you don’t know certain
basic procedures or don’t understand Take Control syntax for things
like working with menus or finding items in the Finder. Please note
the following:

« Path names: The route you take to a file on your hard drive,
whether by looking through columns in a window or by double-
clicking your way through folders, is the file’s path.

The syntax for paths conforms to Unix standards, because that’s
what underlies Mac OS X. The disk’s name is always the first thing
in an actual path; since we can assume that the disk is always
there, we don’t include its name in the path—but we preserve the
slash that would separate it from the next item. So, HardDrive/
System/Library/Fonts becomes /System/Library/Fonts.

A path to something in a user’s home directory starts with the
drive’s name, followed by Users and then the user’s name. The
handy convention, however, is to replace those first three items
with ~ (tilde), so HardDrive/Users/Andrew/Library/Fonts
becomes simply ~/Library/Fonts. (You've probably noticed by
now that path text is formatted in special type.)
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For something a little further down, or back up, in a path that was
just described, or if the beginning of the path is unknown (because,
for instance, it varies from one user to another), we use two
periods to indicate the missing part of the path: “With Creative
Suite, you get /Library/Application Support/Adobe/
Fonts, and its subfolder, . . /Adobe/Fonts/Reqrd/Base.”

Menus: To describe choosing a command from a menu in the
menu bar, this ebook uses an abbreviated description like Edit >
Resolve Duplicates. When the actual command name changes
based on a special situation or selection, there’s a generic refer-
ence: if the command would be File > Remove “NewFlier” based
on the name of the selection, the description is File > Remove
CollectionName.

System Preferences: Working with certain aspects of fonts
means some trips to System Preferences. To get there, choose
System Preferences from the Apple menu. Each icon in the
Preferences window opens a pane of information. So, if I say

“In the International pane of System Preferences” or “in the
International preference pane,” you’ll know you have to choose
Apple > System Preferences and click on the International icon.
Some panes have multiple screens, accessed by clicking their tabs
(titles) in the pane, so the directions might say “...in the Input
Menu tab of the International pane...”.

Assumptions

The “common ground” between what you should have, and know, and
what I'm writing about in this ebook includes:

« You’re working in Tiger: Font management in Mac OS X

changed drastically from one release to the next; little of this ebook

applies to versions before Jaguar, and Font Book changed
immensely just for Tiger.

« You’re working in at least 10.4.3: I was working in 10.4.6
by the time this ebook went “to press,” but 10.4.3 especially fixed
some specific problems in Font Book (enough that I had to delete
some complaints). There’s no excuse not to stay current on free
system updates, so get with it!

This is a free sample of “Take Control of Font Problems in Mac OS X.”
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« You have administrative access to your Mac: he general
assumption is that you’re in charge. (If you're uncomfortable with,
or confused by the very idea of “administrative access,” Appendix D:
Users and Accounts can ease your mind.)

« You know how to use Font Book: You're familiar with its
concepts and capabilities, including: font validation, resolving
duplicates, disabling and enabling fonts, collections, and user-
defined libraries. (You don’t have to know all this—but when, for
instance, I discuss problems with user-defined libraries, I don’t
describe how to create, edit, or remove them.)
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INTRODUCTION

Font problems are a fact of computer life. They shouldn’t be, but
they are.

Often the problems are very minor—why can’t I type a v with
Option-V in this font? Sometimes they're a little more pervasive:
Why isn’t that font showing in the Font menu? Why can’t I empty
the Trash when this font is in it? Why can’t I get Character Palette
to stay listed in the Input menu? And other times they’re dire: Why
is Font Book crashing every time I open it? Why is every menu and
dialog filled with garbled text?

This ebook covers font problems large and small, general and specific.
I provide detailed, step-by-step descriptions of the troubleshooting
techniques you need to know, whether it’s trashing a plist, deleting

a font cache, or starting up in Safe Mode. (That last item, by the
way—almost every description you've read about it lacks important
details regarding font problems!)

A major area of “font problems” that’s not covered in this ebook is
problems that occur with third-party font-management software like
Suitcase Fusion, Font Agent Pro, and Linotype FontExplorer X.
Third-party programs change too often to be reasonably covered in
that way in a book—even an ebook that can be updated more easily
than a printed volume.

This ebook is a companion volume to Take Control of Fonts
in Mac OS X: Tiger Edition

I started out with one standard-sized Take Control ebook. It grew
sort of long. Then it got fairly huge. Then humongous became the
operative term. Then my publishers said it wouldn’t work as one PDF
in terms of the sheer size. So, we decided to split off the bulk of the
content about font problems into another ebook, with enough re-
tooling so it would work as a standalone volume. And here it is!

I don’t mind admitting that it was extremely difficult to figure out
what general, background information should be included in this
ebook, when it’s all detailed in Take Control of Fonts in Mac OS X.
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I don’t want to make you buy that ebook (though if you did, we’d both
be happy) for related, but not problem-specific material. On the other
hand, I don’t want to repeat myself here too much and lead you to
think that this ebook is a collection of reprints. (Don’t you hate TV
shows that claim to be “NEW! episodes” but are just clippings
collected from earlier in the season?) Yet, on the other other hand,
there’s a certain amount of background information that’s necessary,
and another amount that’s useful, for clarification of some points.

So, I settled on excerpting two short but important topics in their
entirety—“The World According to Glyphs” and “Update Legacy
Fonts”—from Take Control of Fonts in Mac OS X. I also borrowed
two handy, informative tables, identified in the text as having come
from the other ebook. And, for your reference convenience, I repeated
some appendixes. I mention all this so that if you bought this ebook
individually, and then buy the other, you won’t feel you've been fooled
or cheated. (At over 250 pages, there’s way more information in the
other ebook than I've excerpted here!)

TIP ORGANIZE, INSTALL, AND USE FONTS LIKE A PRO AND SAVE $5

If you want the entire two-volume set about fonts, but only
bought this volume, you can save $5 on Take Control of Fonts
in Mac OS X by clicking the URL below to open a catalog page
about the ebook. If you choose to purchase, a $5-off coupon
should appear at the upper right of the first screen of the
shopping cart.
http://www.takecontrolbooks.com/fonts-macosx.html

A special notes about the figures

Also “copied” from Take Control of Fonts in Mac OS X is the concept
of using characters buried in basic fonts to point, circle, or otherwise
label items in screenshots. The characters, always in red, are identi-
fied in the margin by their Unicode IDs or GIDs (glyph IDs)—or both,
when a character has both. The two-fold purpose behind this is to
make you aware of the scope of non-alphabetic characters most fonts
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contain, and to get you comfortable with the idea of referencing char-
acters by their various IDs. (You can use Character Palette’s search

function to find these characters by their Unicode IDs.) Pictures with
these kind of attention-getting devices look something like this figure
(though much more sensible).

FIGURE

Circled number:
Hiragino Kaku Pro
U+24D0

Double-head arrow:
Apple Symbols
U+219F, GID 838

Dashed arrow:
Charcoal
U+21E0, GID 369

Dashed Circle:
InaiMathi
U+25CC, GID 277

i
—

—i Password | Picture | Loginitems | Parental Controls j—
T
@These items will open automatically when you log in:
| Hide |ltem Kind
W % FontExplorerXAutoload Application
M @@ QuicKeys == Application
@ i iTunesHelper Application
E f__ﬁ'Sna;:z Pro X Application

1 [8iArchive Assistant Schedule Application
-y
o |_|n & Linotype FontExplorer X

Application

W

e

This com-
bination of
attention-
getting
characters
is just for
fun.

Page 9

This is a free sample of “Take Control of Font Problems in Mac OS X.”
Click here to buy the full 120-page ebook for only $10!



http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU09607629809&PT=TRK-0037-SAMPLE

QUICK START

Solving a font-related problem is a simple two-step process: figure
out what’s causing the problem, and then fix it. Okay, maybe it’s not
that simple: symptoms can have many causes, and causes have many
possible fixes. But with this ebook, you can both narrow down symp-
toms to a probable cause and look up the cure most likely to work.
Even better, you’ll learn how to avoid some problems altogether.

If you’re not in font trouble right now:
o Review the basics in Know What and Where Your Fonts Are.

« Read Take Preventive Measures and Plan Ahead (and implement
its suggestions).

Otherwise, come back to these sections as soon as you're back on
track so you won’t be derailed again.

If you’re unfamiliar with Mac troubleshooting methods:

« Check Table 3: Testing and Fix-it Procedures for a list of the
techniques you’ll need for analyzing and solving font problems.

« Review the specific details for all the techniques in Learn
Troubleshooting Procedures. Table 2: Font Troubleshooting and
Maintenance Tools describes the software utilities you’ll need for
some of the solutions (most of them are provided with Tiger).

If you’re having a problem:

« If you don’t know whether it’s a font problem or a system problem,
review Table 4: Laying the Blame.

« If you suspect it’s font-related but you can’t pinpoint it, try the
steps in Tackle General Font Problems.

« Ifyou have a problem that seems specific, try one of these topics:

 Fix Font Book Problems  Safari
e Manage Input Menu Items « Microsoft Office
« Font Files and Icons « Adobe Applications

Font Menus and the Font Panel e« Classic Fonts and
Environment

Font and Character Formatting
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KNOw WHAT AND WHERE YOUR FONTS ARE

Some basics are so basic that it’s difficult to do anything if you're
not familiar with them. The font formats that Mac OS X supports,
and where those font files can be stored, belong to that category
of basic information.

Learn About Supported Font Types

With respect for the past and a nod to the future, Mac OS X supports
a wide range of font types. What difference does this make to your
troubleshooting efforts?

There is, of course, the obvious item: if you're trying to use an unsup-
ported type of font, it won’t work! But sometimes you can have a font
problem because of a misunderstanding about certain font types, and
where and how they work. PostScript Type 1’s, for instance, need two
files to work at all; dfonts can be used only with Mac OS X, and so on.
Appendix A: Font Specs rounds up the specifications for all the avail-
able font types, which I detail here:

« PostScript Type 1 and bitmapped suitcase companions:
PostScript Type 1 fonts (also referred to as, simply, PostScript or
Type 1 fonts) need two files to work. We’ve inherited this double-
file approach from early Mac days, when one file (the printer,
or outline, font) told the printer what to draw, and the other (the
bitmapped, or screen, font) told that Mac what to put on its screen
and in its Font menus.

A printer file has an LWFN-stamped font icon, and an
@ abbreviated name based on a simple formula: the first

five letters of the font’s “family” name plus the first three
letters of any descriptive words after that. So, Nathanial
Italic Condensed becomes NathaltaCon. In the Finder, a printer
file’s Kind is PostScript Outline font.

LYWWFN

A suitcase file has an FFIL-stamped font icon, and can
v have any name at all—even one unrelated to its contents,
a situation that can lead to some problems. Many suitcase
files have a .bmap (bitmap) or .scr (screen) extension, but
none is necessary. The file’s Finder Kind is Suitcase font.

FFH
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TAKE PREVENTIVE MEASURES AND PLAN AHEAD

I'm not sure how you’d measure an ounce of prevention or a pound of
cure, but the philosophy holds: it takes less time and effort to prevent
a problem than to fix it.

General Guidelines

Follow these simple guidelines to stay trouble-free, or at least make
troubleshooting or fix-ups easier when a problem crops up:

Upgrade, upgrade, upgrade: First, upgrade to Tiger: its
general approach to fonts and native font-handling capabilities
are miles ahead of its Mac OS X predecessors.

Next, keep upgrading Tiger versions. There’s no excuse not to,
since these minor updates are free. And font management is one
of the things that has changed, sometimes significantly, with each
10.4.x version. In fact, the delta upgrade (10.4.4) actually provided
new versions of Courier and Monaco dfonts to correct some glyph-
display problems with CE and CY (Central European and Cyrillic)
characters.

Finally, keep your applications updated with fixes as they become
available, and upgrade to major revisions as soon as it’s financially
feasible. (A major, but nebulous, font problem that lasted for
months for a friend in QuarkXpress 6, no matter what we did,
disappeared when the documents were opened in the beta version
of Quark 7; imagine what the released version will do!)

Don’t remove or disable system-critical fonts: The core
fonts, in /System/Library/Fonts, are Keyboard.dfont,
LastResort.dfont, Monaco.dfont, Geneva.dfont,
LucidaGrande.dfont, and Helvetica.dfont (and probably
AquaKanaRegular.otf and AquaKanaBold.otf).

Stealth fonts: Keyboard, LastResort, and the AquaKanas are

what I call “stealth fonts”; you’ll never see them in your Font menus,
although they’re right there in your System Fonts folder. If, while
in the Finder, you select any of these files and choose File > Get Info,

you'll see that their full names include a leading period, which keeps

them from appearing in menus.
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LEARN TROUBLESHOOTING PROCEDURES

You don’t have to be an expert to perform tasks like a Safe Boot

or setting up a new user account; all you need is the step-by-step
instructions in this section. Some of the procedures here help you
figure out what the problem is, some of them fix problems, and some
do both (as noted in Table 3). I've divided them into three groups:

« General Procedures: This includes things like repairing
permissions, setting up a new user account, and Safe Booting.

« Delete Caches and plists: Mac OS X has font caches, but so do
Microsoft and Adobe programs; and although Font Book’s plist is
practically famous, it’s not the only plist that needs deleting.

+ Restore System Components: You can’t reinstall “pieces”
of the operating system with the Installer, but you can still get
at them, whether you need to replace fonts or Font Book.

Table 3: Testing and Fix-it Procedures

Test | Fix | Procedure Comment
X | Restart the Mac Clears out mistakes in memory
X | Repair system permissions | A long shot, but easy to do
X | Repair font-file permissions | Not needed often
X Try a new user account Narrows the scope of possible problems
X X | Start up in Safe Mode Ignores all but system-level items;
performs housekeeping chores on things
like font cache files and the disk directory
X | Delete caches and plists Dumps possibly corrupted files
X | Restore system components | Replaces fonts, Font Book, Character
Palette, and Keyboard Viewer
X Binary search for bad font Tracks down a bad font
X | Archive and Install Not usually needed for font problems

X’s: MS PMincho: U+2117
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TACKLE GENERAL FONT PROBLEMS

Some problems are obviously font-related: you put in a new font and
it doesn’t show up in a menu or everything starts crashing. And when
you have what’s obviously a font-related problem, sometimes it’s an
easily identified symptom: Font Book doesn’t list all your user-
defined libraries, for example.

But in many situations, it’s not all that clear. Is the crashing from a
systemwide problem totally unrelated to fonts? Is it a problem with

a system component related to fonts (like Character Palette) but not
actually a font problem? And if it seems to be a font problem—is it

a font, or is it Font Book? And how do you approach fixing a problem
whose symptoms are nonspecific? Take a deep, cleansing breath and
follow these steps:

1. Decide the probable cause: Use the guidelines in Table 4
(next page) to assign the blame to font files, Font Book, or a more
general problem. You’'ll find some overlap: Character Palette
issues, for instance, could be blamed on Character Palette itself
(a system component), but since Character Palette is somewhat
sensitive to corrupt fonts, the problem might be a bad font.

2. Try a quick fix: If you can identify a font-related problem
in addition to general symptoms (you may be crashing a lot ran-
domly, but you’ve noticed Character Palette doesn’t always open
the first time you choose it from the Input menu), look through
Learn Troubleshooting Procedures for related actions (deleting
Character Palette’s plist, for instance). This can take less time—
even if you try two or three procedures—than a full-blown analysis
to narrow down the problem.

3. Analyze the problem further: The flowchart in Figure 5
shows you how to use various troubleshooting procedures to zero
in on your problem. In many cases, one of the steps in the chart
will also fix the problem you’re having.

« If your path takes you to the “Unlikely a font problem” box, you
should consult a general Mac troubleshooting reference; you
may have no option other than to Perform an Archive and
Install, as noted in the chart.

« If you wind up in either of the red boxes, proceed to Step 4.
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FIx FONT BOOK PROBLEMS

It’s not always easy to differentiate general font problems from those
caused by Font Book (see Table 4 for help with that)—which means
it’s not all that clear what you should do about them, either. If you're
convinced that you have a Font Book problem but can’t pinpoint it,
solutions for nonspecific problems follow immediately after this list
of links. If you can pinpoint the problem a little—it seems connected
to user-defined libraries, say, or the dots that mark duplicate fonts
don’t seem to make sense—try the appropriate link from this list:

A font isn’t in the expected folder or library after you install it
Font Book can’t see a font in a Fonts folder

A font is listed in the User library but not in All Fonts

The Font list shows a double listing for the same font

The preview area displays the wrong font

The preview area shows nothing in Sample view, and you can’t
type anything in Custom view

The Classic library isn’t listed
There’s no Removal confirm dialog
Your disabled fonts are re-enabled

A TrueType font is marked as disabled in Font Book but shows up
in Font menus

Duplicate-dot dilemmas in the Font list
Resolving duplicates disables every copy of a font
Multiple fonts or typefaces disappear when one is removed

A font doesn’t show up in Font Book (or menus) after you’ve added
it to a folder that you’ve defined as a user library

Library contents disappear when the library is renamed
Collections or user libraries misbehave
Collections or user libraries disappear from the Collection list
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MANAGE INPUT MENU ITEMS

Character Palette, Keyboard Viewer, and input keyboards live in the
Input menu; the first has far more problems than the other two—but
the latter two aren’t perfect, either! And the Input menu itself occas-
ionally has some problems. (If you don’t even have one in your menu
bar, jump directly to You have no Input menu.)

Character Palette

While Character Palette isn’t a shining example of an obvious
interface, it’s extremely useful—and sometimes your only option for
inputting off-the-keyboard characters. The more you use it, the more
you’ll like it. And the more you’ll increase your chances of running
into problems with it.

Character Palette problems that aren’t problems
Items that may seem like problems but are actually features (no,
really—I didn’t mean that sarcastically) include:

« Some installed fonts aren’t available in the pop-up menu
in Glyph view. The menu doesn’t show disabled fonts or fonts in
application Fonts folders—a font must be viewable in Font Book to
be seen in Character Palette.

« The Insert or Insert With Font button is always dimmed.
Always? This button is dimmed more often than not; if you're in a
program that can’t display non-Unicode glyphs and you’ve picked
one of those for insertion, you're out of luck (more details in
Excerpt 1: The World According to Glyphs). The button also
remains dimmed if you’re using a program that doesn’t work with
Unicode at all, like Word X.

« Nothing ever shows in the Glyph Variants section.
Nothing? Ever? Try selecting the glyph for the numeral one and
then select the Zapfino sample in the Collections area. It just
seems like nothing ever shows up because so few standard fonts
have glyph variants defined.
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SOLVE OTHER SPECIFIC PROBLEMS

If you’ve dealt with a hard-to-pin-down font problem, you might

find it a relief to deal with one that’s more specific in nature: an icon
changes, a font file can’t be erased, character formatting doesn’t seem
to “take”... all sorts of annoying but identifiable things. The problems
and solutions are divided into the following categories (click on a link
to jump to the one you need help with):

« Font Files and Icons (this page) e« Font and Character Formatting
 Postscript Fonts « Safari
e Font Menus and the Font Panel e« Microsoft Office

« Classic Fonts and Environment « Adobe Applications

Font Files and Icons

You can guess what might go wrong with a font file—from not being
able to copy it to its refusing to be thrown out with the Trash—but
you’d be amazed what can go wrong with the icons themselves!

A font file can’t be moved or copied

Some old font files put up a fuss when you try to copy them or move
them from one folder to another. Reset font file permissions to make
them behave.

If you're working with fonts in /System/Library/Fonts (or
/Library/Fonts when you don’t have administrative privileges),
it’s normal for a font file to refuse to move out of the folder, simply
make a copy of itself in the target location; see Remove or Reinstall
a System Font for details.

A font refuses to go out with the Trash
There are several reasons a font might not go gentle into that good
Trash, and several solutions to try:

- If the font was dragged to the Trash directly from a Fonts
folder or user-defined library: It’s likely Tiger thinks it’s still
using the font (even if you replaced it with a file of the same name
to get a better version). Delete the system font caches, and don’t
forget that a restart is part of the procedure.
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EXCERPT 1: THE WORLD ACCORDING TO GLYPHS

This is an excerpt from the ebook Take Control of Fonts in Mac OS X:
Tiger Edition (see the tip on page 8 for more information and a dis-
count). Its inclusion in this ebook can be seen as a shameless plug
for another ebook, or as a munificent dissemination of useful
information. Or both.

A glyph, in fontspeak, is a single entity of a particular shape. You can
refer to an uppercase A as a letter or a character, but there’s only one
such animal; it does, however, come in many different designs, or
shapes. All the characters in this picture are A’s, but there are 13
different glyphs.

AAAVIAAAAAAAA

A glyph doesn’t always represent a single character. It can be a
double-letter ligature, a triple-character fraction, or a multiple-letter
Roman numeral. (The Zapfino font has a separate, single glyph for
the word Zapfino.) No matter how many characters seem to be in

a glyph, it is always a single entity in a font; it might take multiple
keystrokes to generate it, but a single backspace will delete it.

The Unicode system provides for a single instance of a character in
each script (written language): there is one capital A in Unicode, and
its ID is U+0041. A font, on the other hand, can have multiple repre-
sentations of a single character: alternate capital A’s, standard and
Small Caps versions, and so on. A font can also contain glyphs that
have no relationship to any Unicode character.

Since every character you see and store on a computer must be
represented by some sort of numeric ID, and so many glyphs fall
outside the range of Unicode characters, there’s a whole 'nother iden-
tification system, in addition to Unicode: the glyph ID (GID). Each
glyph in a font has a GID, even if it also has a Unicode ID. There’s no
standardization for this: the GIDs for three alternate A’s in one font
won’t match those for alternate A’s in another, and a fancy flourish
in one font is unlikely to have a counterpart in another.

Even the most basic of characters across fonts don’t necessarily have
the same IDs: the question mark might have a GID of 34 in one font,
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EXCERPT 2: UPDATE LEGACY FONTS

This is an excerpt from the ebook Take Control of Fonts in Mac OS X:
Tiger Edition (see the tip on page 8 for more information and a dis-
count).

If you're not new to the Mac, you may have a few old font favorites,
or even a vast collection, that you have no intention of giving up. But
your fonts may not be ready for Mac OS X, which has more stringent
requirements when it comes to font files:

« Mac OS X can’t use a single-font file for either bitmapped or
TrueType; fonts must be in suitcase files, even if the suitcase holds
only a single font.

« You must trim down multiple-font suitcases, separating TrueType
from bitmapped, and the bitmapped wheat from the chaff (the
ones you need for PostScript fonts, and the ones you don’t).

But you can’t manipulate suitcase contents in Mac OS X. Even if
you’re in Classic, you can’t open suitcase files the way you did in Mac
OS 9, because Classic is not really an operating system, it just plays
one on your Mac. Manipulation issues aside, you can’t even be sure
of a suitcase’s contents because double-clicking it opens windows in
Font Book for the TrueType contents, but not for all the bitmaps.

So, how can you handle this particular chore? You have three options:

« Work directly in OS 9: Use your own Mac if it can boot into
OS 9, or on another machine. (Some apologies, or even begging,
may be required if you’ve been giving OS 9 friends a hard time
about not moving up to Mac OS X.) I recommend this method,
since it’s the only one that lets you handle single-font files. To
get started, see Work with suitcases in Mac OS 9.

« Work in the Classic environment: Install it on your machine
if it’s not there already, and get... ready for this?... Font/DA Mover
4.1, last seen with System 6. I cover how to get it and how to use
it in Use Font/DA Mover.

« Get a third-party utility that lets you manipulate suitcases.
The only utility for this that 'm aware of is Smasher. It lets you
redistribute suitcase contents although it doesn’t handle single-

This is a free sample of “Take Control of Font Problems in Mac OS X.”
Click here to buy the full 120-page ebook for only $10!

Page 99


http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU09607629809&PT=TRK-0037-SAMPLE

APPENDIX A: FONT SPECS

Table 7: Font Specs

Name or Description Finder Font Book Comment
Extension Kind Kind
Supported in Mac OS X
Bitmapped suitcase
\\5 .bmap or .scr Original Mac Font (Companion file] Supported only
__FFHl (optional) screen font; Suitcase shows as Post- | as PostScript
companion to Script Type 1) | Type 1 com-
PostScript Type 1 panion font
PostScript printer font (Type 1)
\‘§ 5-letter family | Outline font; PostScript | PostScript Needs
s name plus 3 needs bitmap Type 1 Type 1 companion
letters for each | FFIL companion | outline bitmap file
style font
TrueType (Mac)
\‘§ Font family Single or Font TrueType
_ name multiple Suitcase
TrueType fonts
in a suitcase file
TrueType (Windows)
\‘§ Font family Cross-platform Windows TrueType
TTE name TrueType
ttf or .ttc font
extension
Multiple Master instance
\‘ﬁ Same as A special PostScript | PostScript Basically a Type
LWFN PostScript PostScript Type |Type 1 Type 1 1 font; its
printer font 1 font, editable outline companion
\15 and suitcase, in previous font suitcase file also
: plus “MM” systems has MM in its
FFHl name
(continues)
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APPENDIX B: TIGER FONTS

The three tables in this appendix list the fonts Tiger installs:

« System Fonts folder:
Fonts always installed in /System/Library/Fonts, Table 8 (below)

« Library Fonts folder:
Basic fonts always installed in /Library/Fonts, Table 9

« Library Fonts folder:
Additional fonts installed as an option in /Library/Fonts, Table 10

Table 8: Basic Tiger Fonts in the System Fonts Folder

Font File Language/ | Font File Language/
Script Script

AppleGothic.dfont Korean HiraginoMincho ProW6.otf | Japanese

AquaKanaBold.otf Japanese Keyboard.dfont

AquaKanaRegular.otf Japanese LastResort.dfont

Courier.dfont LiHei Pro.ttf Chinese

Geeza Pro Bold.ttf Arabic LucidaGrande.dfont

Geeza Pro.ttf Arabic Monaco.dfont

Geneva.dfont Osaka.dfont Japanese

Hei.dfont Chinese OsakaMono.dfont Japanese

HelveLTMM STHeiti Light.ttf Chinese

Helvetica LT MM STHeiti Regular.ttf Chinese

Helvetica.dfont Symbol.dfont

Hiragino Kaku GothicPro W3.otf | Japanese Times LT MM

Hiragino Kaku GothicPro W6.otf | Japanese Times.dfont

Hiragino Kaku Gothic Std W8.otf | Japanese TimesLTMM

Hiragino Maru GothicPro W4.otf | Japanese ZapfDingbats.dfont
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APPENDIX C: THE D0 NOT REMOVE"” FONT LIST

Table 11: Do Not Remove These Fonts

Font

Location

Reason

From Tiger: Absolutely Necessary

AquaKanaBoldT
AquaKanaRegulart
Geneva

Helvetica*
Keyboard
LastResort
LucidaGrande

/System/Library/Fonts

The operating system
needs them

Monaco
Helvetica LT MM /System/Library/Fonts Preview uses them for
Times LT MM font rendering

From Tiger: Recommended

Courier
Symbol
Zapf Dingbats

/System/Library/Fonts

Comic Sans
Georgia
Trebuchet

Times New Roman
Verdana

/Library/Fonts

Common Web and cross-
platform fonts

From Adobe

All fonts in folder

/Library/Application Support/
Adobe/PDFL/7.0/Fontstt

Acrobat and Acrobat
Reader need them

All fonts in folder

/Library/Application
Support/Adobe/Fonts/Reqrd/Base

Adobe applications need
them

* May be replaced by another version of Helvetica in any Fonts folder the system can access.
T May not be essential; anecdotal evidence indicates it is.
t1 The number in the path may be different
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APPENDIX D: USERS AND ACCOUNTS

If you’ve ignored the whole user account thing up until now and feel
practically illiterate when you run into Fonts folder pathnames, or
references to setting up a separate account to test your font problems,
relax: it’s simpler than you think.

Mac OS X is designed as a shared system, serving the needs—and
preserving the privacy—of more than one user, whether the users are
various employees or a few family members. If you're the sole user,
you have to put up with some nonsense that’s a result of the shared-
Mac approach, with multiple places to store (and misplace) things,
folders that seem to have the same names, and the concept of having
an account on your Mac—an account with an administrator, who, in
all likelihood, is you. You run into the surface issue of this approach
every time you install software and you’re asked for an administrative
password (and doesn’t that make you feel important?).

For most practical purposes, you can think of a Mac as starting with
a single user account, a setup for a single user. Each user account has
an owner, the person who has a password to use it. At least one user
account has administrator privileges; the owner of an account with
these privileges is allowed to make systemwide changes on the Mac
that can affect all the accounts on it—like installing applications or
updating system software. The first user account that’s set up on your
Mac OS X machine automatically has administrator privileges. So,

if you're the only user, you have an account with administrator
privileges. (You are the boss of you.)

The multi-user mindset of the operating system results in a hierarchy
of resources and privileges:

« System stuff: These are items the Mac needs to keep humming—
everything from starting up, to putting a dialog on the screen, to
opening an application when you double-click a document.

« Communal stuff: Things that every user account can access, like
applications, which are normally installed only once, in one place,
and shared by everyone.

« User stuff: Things that are private to each user, like documents
(obviously) and environmental things like the Desktop background
and preference settings.
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In contrast to traditional print books, Take Control ebooks offer
clickable links, full-text searching, and free minor updates. We hope
you find them both useful and enjoyable to read.
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When Sharon Zardetto Aker wrote her first computer book, her sons
were not even in preschool; now they’re both out of college. She has

a long Mac history, starting with a 1984 Mac (128K of memory, 400K
floppy disks), and articles in the earliest issues of Macworld and the
premiere issue (and every one thereafter, for many years) of MacUser.
Her nearly a thousand magazine articles over the years include a
regular MacUser column on portable computing. Her 20 or so books
include many editions of The Macintosh Bible, as well as The Mac
Almanac—whose especial claim to fame is having been part of an
answer on the Jeopardy board—on TV, not the play-at-home version.
(The correct question was: “What is a computer?” Really!)

After an almost 5-year hiatus from writing, during which she de-
signed and programmed databases, and created online educational
material for pharmaceutical firms, she decided to dive back in with
Take Control ebooks. You can send her email about this title at
sharonzaker@optonline.net; she can’t promise a response to every
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band in an Apple Computer store. (Double-sided floppies had also
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